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Search engines 

A search engine is a tool we use to find websites and information on the Internet. Search engines will search other computers connected to the Internet and classify the files they find on these computers. Some search engines ‘crawl’ or ‘spider’ in different ways, while others create directories. Therefore, search engines need access to different computers connected to the Internet. For these reasons it is useful to use a variety of search engines.

Common search engines 

At the time of writing, the most commonly used search engines include:

· Google

· Yahoo

· MSN

· Lycos

· AltaVista

· Netscape

· Ask.

The URLs for each of these search engines are included in the Research section of this Learning Pack.

Differences between search engines

There are a huge variety of search engines. Most search engines explore most of the computers connected to the Internet. However, some ‘search engines’ are really a search of a particular site, or perhaps a group of sites. 

Some specialist search engines are based on specific topic areas. For example, Web Wombat was the original Australian search engine. When you use this search engine you will find your results listed in order of relevance to Australia. 

Other examples include:

· Lexplore — specialises in information related to international law

· Travelocity — specialises in information related to travel

· Hotwire — specialises in information related to computer and communications technology.

How to search the Internet

How to create a search expression

In order to use a search engine, you must first locate the search engine on the Internet. Usually you would do this either by typing in the URL of the search engine you wish to use. A search bar will appear and you type your expression into this bar. How you express your search will be explained later. 
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Figure 1: The URL and search bar in Google

This is the search bar in Google. Access this screen by typing in the URL http://www.google.com.

Alternatively, you might click on the Search button on the toolbar of your browser. This will take you to a search engine screen to allow you to enter your search expression. Note: if you use the Search button, your browser may randomly generate which search engine to use for your search.
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Figure 2: The Ninemsn search engine in the left of the browser window — accessed by first clicking on the Search button.

Composing a search expression

When you are looking for search terms try to:

· Type in the question in a full English sentence.

· Use just the main keywords.

· Add more keywords to narrow down (reduce) the number of hits.

· Define (by clicking a button) if you wish to search the entire web, or if you just wish to search Australian sites.

· Use synonyms for the keywords.

· Use acronyms.

· Use words to broaden your search like OR.

· Use words to narrow your search like AND, +, -, NOT.

· Use double quotation marks to ensure the phrase you are using is located in exactly that sequence.

Also try different search engines. You will most likely get different results from the same search terms. 

How to narrow or broaden a search

The trick to getting good results from your search expression is to be able to broaden or narrow your search as required. For some topics, you will get millions of results (or hits), while for others you might get none. As pointed out above you can:

· Use words to broaden your search like OR.

· Use words to narrow your search like AND, +, -, NOT.

Instead of using Ninemsn, now let’s have a look at what we will achieve in Yahoo. Let’s search for information on the IT Certificate 2 qualification.
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Figure 3: Yahoo search

Using Yahoo and searching ‘the Web’ we come up with 26,700,000 results, or hits. This is way too many! Let’s see what happens if we put this phrase in double quotations and set the search for Australia only.
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Figure 4: Yahoo search with more parameters

This time we have come up with 724,000. Still way too many to try to get to what we want.

Let’s assume it is the Certificate 2 through TAFENSW that you are looking for. Let’s add TAFENSW and see how we go.
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Figure 5: Yahoo search with fewer results

Now we have narrowed our results to 25,000. Let’s think more about what we are looking for. Assume you want to know where this course is being conducted. Let’s narrow the search by adding the word location.

[image: image6.png]R o oo oo o AT A bt oS08 bt
Wob S | oty iues | it |t
W SEARCH [TCuticate 2 eTATE oW andocabon | |50

ek e e T B





Figure 6: Yahoo search with fewer results still

5,850 hits. We’re certainly reducing the amount of information to be filtered. Though, this is still way too many results to work through.

Let’s investigate a different search engine using the same expressions. Firstly, IT Certificate 2 across the Web.
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Figure 7: Google search without quotation marks

Without quotation marks we got 31, 600,000 hits, close to the results using Yahoo.com.
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Figure 8: Google search with quotation marks

Wow, how about that? By placing the phrase in double quotation marks, we’ve narrowed our search to 22 hits using Google. This is much more manageable. Let’s see if we can get to the locations where the certificate is offered.
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Figure 9: Google search with +

We now have four hits when we add + locations. 

Let’s try something really specific, like a course offered by OTEN.
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Figure 10: Google search with OTEN included

We’ve now got down to ten hits using the search expression:

“Certificate 2 in Information Technology” + OTEN.

It is possible to narrow the search too far, however. For example, if I were to put the entire phrase in double quotations and search on this, let’s see how we go.
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Figure 11: Results of the search expression “Certificate 2 in Information Technology OTEN” all in double quotations

The results above show that this is unlikely to be recorded as one sequence of text, so the search engine can’t find anything matching this particular entry when we put double quotations around the whole phrase.

So now you have identified some of the ways to narrow and broaden a search using search engines. Notice that different search engines will give you different results. Different search operators, such as double quotations, + and – symbols, AND, OR, NOT will also give you different results.

A special note here is that the Internet is a very dynamic world. Information located using search engines varies on a daily, and sometimes hourly, basis. If you were to carry out the searches above it is unlikely that you would come up with the same results. However, the principles of using operators to narrow or broaden a search, and using a variety of search engines, always remain true.

How to access, save and print search results

How to access search results

If you were to do a search for OTEN and click with the left mouse button on the hyperlink for the first entry below you will go directly to the OTEN site.
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Figure 12: Click on the hyperlink to access search results
From the OTEN website you could follow a number of hyperlinks including getting all the way back to OTEN’s home page by clicking on About OTEN on the left side of the screen or the Home button at the top of the screen.

If you were not happy with the information you found at this website, you would click on the Back button.
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Figure 13: Using the Back button
You would return to your list of search results. From here you can click on any hyperlink you wish to view the details of other search results.

How to save search results
You can save the results of your search in a number of ways. Generally you would display on the screen the web page of a particular search result. You can then save the search results in one of two ways:

1
You can save the entire page as an HTML (web page) file.

2
You can copy and paste the contents of a web page into a word document.

1 Save the entire page as an HTML (web page) file

To save the entire page as an HTML (web page) file, follow these steps:

· Choose the File menu.

· Click on Save As.

· Choose the location you wish to save your web page to, ie the drive as well as the folder you wish to use.

· Click on Save.
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Figure 14: File Menu, showing Save As command
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Figure 15: Choose a folder to save into
On the Save Web Page screen, when you click on Save, the file IT Framework Course – Information Technology will be saved into the OTEN folder in this example.
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Figure 16: The file saved

Notice that a folder holding all the graphics relating to this web page is also saved. This allows all information to be viewed offline, ie when you are no longer connected to the Internet.

2 Copy and paste the contents of a web page

You can copy and paste the contents of a web page into a word document and then add any further information you need to create a report:

· Select the text and graphics you want to copy for your report by click-dragging over the text you want.
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Figure 17: Only the selected text will be copied

· From the Edit menu choose Copy.

· Open your word processor program and paste the text. You can then add to, take away from and adjust it as needed. You should keep in mind copyright issues when you are pasting text from a website to create a word processing document.
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Figure 18: This text has been added in the word processing file
In the figure above, text is copied by using a word processing program with heading and other information added to create a report. This report can now be saved as a word processing file in the usual way.

How to print search results

The results of a search can be printed in two ways.

The first way:

1
Choose File menu, then Print Preview. 

2
If you are happy with what will be printed, click on the Print button.
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Figure 19: Print preview

On clicking the print button you would create a hard copy of the two pages of this web page. Notice that you will also print the page title (the name at the top of each page), and the URL of the page at the bottom of the page. 

The second way:

1
Select the text and graphics you want to print. 

2
Choose File menu, then Print.

3
At the next screen, go to Page Range, click in the circle next to the word Selection. 
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Figure 20: File menu with Print selected
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Figure 21: Only the highlighted information will be printed

By choosing Page Range, Selection from this screen, (note the dot against this option in the screen above) only that information selected in the left area of the screen would be printed.

Bookmarks and favourites

The terms bookmark and favourite refer to the same function of a browser. In Netscape, the term used is Bookmark, while in Internet Explorer the term used is Favourite. You can use bookmarks to store the locations of websites you use often or find of particular value. Of course, this saves having to remember the URL of the particular website you have visited and saves lots of time when accessing the Internet. You can also organise your bookmarks, or favourites, into folders so that information on any particular topic can be grouped together. This is a really useful way to avoid having to search many times for something you’ve visited in the past.

How to place a bookmark or favourite
In Internet Explorer:

1
Go to the website you wish to save as a favourite.

2
Choose Favourites menu or click on the Favourites button on the toolbar.

3
Choose Add To Favourites.

4
At the next screen, click on Create In if you cannot see the New Folder option.

5
Now click on New Folder if you wish to create a new folder.

6
Name your folder and click on OK.

7
Ensure the folder you want to save into is open.

8
Change the name of the page against Name if you feel it is not a very helpful name.

9
Click on OK.
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Figure 22: Choose Add to Favourites from the Favourites menu
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Figure 23: New folder option

In Netscape:

1
Go to the site you wish to save as a bookmark.

2
Choose View Menu or click on Bookmarks on the toolbar.
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Figure 24: The View menu in Netscape

3
Choose Bookmarks.

4
Choose Add Bookmark.

5
At the next screen, click on File Bookmark if you cannot see the New Folder option.

6
Now click on New Folder if you wish to create a new folder.

7
Name your folder and click on OK.

8
Ensure the folder you want to save into is open.

9
Change the name of the page against Name if you feel it is not a very helpful name.

10
Click on OK. 

How to return to a bookmark or favourite

In Internet Explorer:

1
Choose Favourites menu or click on Favourites button on the toolbar.

2
Click on the name of the website you have saved, or if necessary double-click to open the folder holding the name of the website. Then click on the name from this list.

3
Your browser will display the website requested.

In Netscape:

1
Choose View menu or click on Bookmarks on the toolbar.

2
Click on the name of the site you have recorded, or if necessary double click to open the folder holding the name of the site. Then click on the name of the site you have recorded from this list.

3
Your browser will display the website requested.

Summary

In this reading we’ve looked at a variety of search engines and search expressions. We have discovered that search engines vary slightly in the way they carry out searches, and therefore in the search results you will get. 

We’ve also discovered that there are a number of ways to broaden and narrow a search to get useful information from the Internet.

Having successfully retrieved the information from the Internet, we have looked at three different ways to save this information electronically or in hard copy form.

A quick way of retrieving information you have previously found on the Internet is to record ‘favourites’ or ‘bookmarks’, then return to them by choosing them from your personalised list.
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